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Evaluating the AD7175-8 24-Bit, 250 kSPS, Sigma-Delta ADC with
20 ps Settling and Integrated Analog Input Buffers

FEATURES

Full featured evaluation board for the AD7175-8

PC control in conjunction with the Analog Devices, Inc.,
SDP-B board (EVAL-SDP-CB1Z)

PC software for control and data analysis (time domain)

Standalone capability

EVALUATION KIT CONTENTS

EVAL-AD7175-8SDZ evaluation board
AD717x Eval+ software CD
7V to9V ac-to-dc adapter

ADDITIONAL EQUIPMENT NEEDED

DC signal source
PC running Windows® XP to Windows 10

GENERAL DESCRIPTION

The EVAL-AD7175-8SDZ evaluation board features the
AD7175-8, a 24-bit, 250 kSPS analog-to-digital converter
(ADC) with integrated analog input buffers, on-board power
supply regulation, and an external amplifier section for amplifier
evaluation. A 7 V to 9 V ac-to-dc adapter is regulated to 5 V
and 3.3 V; this supplies the AD7175-8 and support components.
The evaluation board connects to a USB port via the system
demonstration platform (SDP) controller board EVAL-SDP-CB1Z
(SDP-B).

The AD717x Eval+ software fully configures the AD7175-8
device functionality via a user accessible register interface and
provides dc time domain analysis in the form of waveform
graphs, histograms, and associated noise analysis for ADC
performance evaluation.

Full specifications on the AD7175-8 are available in the product
data sheet, which should be consulted in conjunction with this
user guide when working with the evaluation board. Full details
for the SDP-B controller board are available on the Analog
Devices website.
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Figure 1. EVAL-AD7175-85DZ Block Diagram

PLEASE SEE THE LAST PAGE FOR AN IMPORTANT
WARNING AND LEGAL TERMS AND CONDITIONS.
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EVAL-AD7175-8SDZ QUICK START GUIDE

RECOMMENDED QUICK START GUIDE
Follow these steps to set up the board:

1. Disconnect the SDP-B board from the USB port of the PC.
Install the AD717x Eval+ software from the enclosed CD.
Restart the PC after installation.

Connect the SDP-B board to the EVAL-AD7175-8SDZ
evaluation board, as shown in Figure 2.

Fasten the two boards together with the enclosed plastic
screw washer set.

Connect the external 9 V power supply to Connector J4

of the evaluation board, as shown in Figure 2. Set LK2 to
Position B.

Connect the SDP-B board to the PC via the USB cable. For
Windows® XP, you may need to search for the SDP drivers.
Choose to automatically search for the drivers for the SDP-B
board if prompted by the operating system.

From the Analog Devices subfolder in the Programs
menu, launch the AD717x Eval+ software.
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QUICK START NOISE TEST

Use the following procedure to quickly test the noise
performance:

1. Insert Link LK5 to Link LK20 to initiate the noise
performance test mode. In this mode, analog input
channels short to the REFOUT pin via SL11.

In the evaluation software, click Start Sampling to acquire

samples from the ADC (see Figure 16).

The Samples numeric control in the top right corner of the
main window sets the number of samples collected in each

batch.
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Figure 2. Hardware Configuration, Setting Up the EVAL-AD7175-85DZ
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EVALUATION BOARD HARDWARE

DEVICE DESCRIPTION

The AD7175-8 is a highly accurate, high resolution, multiplexed,
8-/16-channel (full/pseudo differential) £-A ADC. The AD7175-8
has a maximum channel-to-channel scan rate of 50 kSPS (20 ps)
for fully settled data The output data rates range from 5 SPS to
250 kSPS. The device includes integrated analog input and
reference buffers, an integrated precision 2.5 V reference, and

HARDWARE LINK OPTIONS

See Table 1 for the default link options. By default, the board is
configured to operate from the supplied 9 V ac-to-dc adapter
connected to Connector J4. The 5 V supply required for the
AD7175-8 comes from the on-board low dropout regulator
(LDO). The ADP1720, with a 5 V fixed output voltage, receives
its input voltage from ]2 or J4 (depending on the position of LK2)

an integrated oscillator.

and generates a 5 V output.

Table 1. Default Link and Solder Link Options

Link

Default Option

Description

LK1

A

Selects the voltage applied to the power supply sequencer circuit (U3); dependent on AVDD1. Place this
link in Position A if using 5V AVDD1, or Position B if using 2.5V AVDD1.

LK2

B

Selects the external power supply from Connector J3 (Position A), or J4 (Position B).

LK5 to LK20

Inserted

Inserting these links sets up the on-board noise test. In this mode, all inputs short to the common voltage
viaSL11.

SLO

A

Routes A0 to one of the following:

Position A: AINO/REF2— pin on the AD7175-8

Position B: Buffer U6

Position C: U7 for use with a single-ended to differential driver circuit
Position D: J15-1

SL1

Routes A1 to one of the following:

Position A: AIN1/REF2+ pin on the AD7175-8

Position B: Buffer U6

Position C: U7 for use with a single-ended to differential driver circuit
Position D: J15-7

SL2

Routes A2 to one of the following:

Position A: AIN2 pin on the AD7175-8

Position B: Buffer U10

Position C: U9 for use with a single-ended to differential driver circuit

SL3

Routes A3 to one of the following:

Position A: AIN3 pin on the AD7175-8

Position B: Buffer U10

Position C: U9 for use with a single-ended to differential driver circuit

SL4

Sets the voltage applied to the AVDD?2 pin. Operates using the AVDD1 supply (default). Position B sets the
AVDD?2 voltage to the 3.3V supply from the ADP1720 3.3V regulator (U11).

SL5

Selects between an external or on-board IOVDD source. Supplies IOVDD from the ADP17203.3V
regulator (U11) (default). The evaluation board operates with a 3.3V logic.

SL6

Removed

Position A connects Crystal Y1 as an external MCLK clock source. Position B connects the MCLK SMA/SMB
connector for use as a clock input or an ADC internal clock output.

SL7

Selects between an external or on-board AVDD1 source. Supplies AVDD1 from the ADP1720 5V regulator
(U8) (default).

SL8 to SL9

Selects between a 5V and 2.5V LDO supply for AVDD1. Supplies AVDD1 with 5V (default).

SL10

Selects the voltage applied to the AVDD1 pin. Operates using the supply set up by Link SL8 to Link SL9
(default). When inserted in Position B, sets the AVDD1 voltage to the 3.3V supply from the ADP1720 3.3V
regulator.

SL11

A

Selects the voltage applied to analog input during on-board noise test (LK5 to LK20 inserted). Position A
connects to the AD7175-8 REFOUT pin. Position B connects to GND. Position C connects to AVSS.

SL12to SL15

Inserted

Connects AVSS and AGND for single-supply operation. To operate in split supply mode, remove these links.
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SOCKETS AND CONNECTORS
Table 2. Connector Details
Manufacturer
Connector | Function Connector Type Manufacturer | Number Order Code’
J Connector to the SDP-B 120-way connector, Hirose FX8-120S-SV(21) FEC1324660
0.6 mm pitch
AOto A3 Analog inputs to the ADC Straight PCB mount Tyco 1-1337482-0 Not applicable
SMB/SMA jack
J3 External bench top voltage supply for Power socket block, Phoenix MC 1,5/ 3-G-3,81 FEC3704757
the EVAL-AD7175-85DZ 3-pin, 3.81 mm pitch | Contact
J4 External ac-to-dc adapter input for the DC power Kycon KLDX-SMT2- MOUSER 806-
EVAL-AD7175-85DZ,7Vto9V connectors, 2 mm 0202-A KLDX-SMT20202A
SMT power jack
J5 External bench top voltage supply Screw terminal Phoenix MKDS 1/4-3.81 FEC3704592
option for AVDD1/AVDD2 and IOVDD block, 3.81 mm pitch | Contact
inputs on the AD7175-8
J8 GPIO terminal Power socket block, Phoenix MC 1,5/ 4-G-3,81 FEC3704749
4-pin, 3.81 mm pitch | Contact
J10and Analog input terminal block; wired Power socket block, Phoenix MC 1,5/ 8-G-3,81 FEC3704774
J12 connection to external source or sensor | 8-pin, 3.81 mm pitch | Contact
J14 Analog input terminal block; wired Power socket block, Phoenix MC 1,5/ 6-G-3,81 FEC3704762
connection to external source or sensor | 6-pin, 3.81 mm pitch | Contact
J15 Optional header 7-way, 2.54 mm pin Samtec SSW-107-01-T-S FEC1803478
header
J16 Optional header 7-way, 2.54 mm Samtec TLW-107-05-G-S FEC1668499
socket
' Order codes starting with FEC are for Farnell.
POWER SUPPLIES

SERIAL INTERFACE

The EVAL-AD7175-8SDZ evaluation board connects to the
Blackfin® ADSP-BF527 on the SDP-B controller board via the
serial peripheral interface (SPI). There are four primary signals,
CS, SCLK, and DIN (all inputs), and one output from the ADC,
DOUT/RDY.

To operate the evaluation board in standalone mode, disconnect
the AD7175-8 serial interface lines from the 120-pin header by
removing the 0 Q, R9 through R13 links. Use the test points to
connect the signals to an alternative digital capture setup.

Power the evaluation board from the ac-to-dc adapter
connected to J4, or from an external bench top supply applied
to J3 or J5. Linear LDOs generate the required voltages from the
applied input voltage (Viv) rail when using J3 or J4. Use J5 to
bypass the on-board regulators. The regulators used are the 5V
fixed output voltage and 2.5 V adjustable output voltage
ADP1720 devices, which supply the AVDD1 and AVDD2 rails
to the ADC; the ADP1720 (3.3 V) supplies the IOVDD rail. Use
the ADP7104 (5 V) to supply 5 V for the SDP-B controller
board. Each supply is decoupled where it enters the board and
again at each device. Table 3 shows the various power supply
configurations available, including split supply operation.
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Table 3. Power Supply Configurations'

Configuration | InputVoltage Range | Description

Single Supply 7Vto9V
(Regulated)
Single Supply 7Vto9V,5V, and
(Unregulated) 33V

Split Supply 7Vto9Vand-2.5V
(Regulated)
Split Supply 7Vto9V,+25YV,

(Unregulated) and 3.3V

The 7V to 9V input is regulated to 5V for AVDD1/AVDD2 and 3.3V for IOVDD. This supply also
powers the external 5V reference. See the Single Supply (Regulated) section.

The input is unregulated and connects directly to AVYDD1/AVDD2 and IOVDD from J5.The 7V to
9V input powers the external 5V reference. See the Single Supply (Unregulated) section .

The 7V to 9Vinput is regulated to 2.5 V for AVDD1/AVDD2 and 3.3 V for IOVDD. The 7V to 9V input
powers the external 5V reference, and the —2.5 V input is connected to AVSS directly (unregulated).
See the Split Supply (Regulated) section.

The input is unregulated and connects directly to AVYDD1/AVDD2 and IOVDD from J5.The 7V to
9V input powers the external 5V reference. See the Split Supply (Unregulated) section.

T Only one configuration can be used at a time.

POWER SUPPLY CONFIGURATIONS
Single Supply (Regulated)

There are two available power supply options for the single-
supply (regulated) configuration.

e Anac-to-dc adapter (included) connected to J4. Set LK2 to
Position B.

e A bench top power supply connected to J3. Set LK2 to
Position A and ensure that AVSS = AGND =0 V.

Set all other links and solder links to the default settings as
outlined in Table 1.

Single Supply (Unregulated)
To set up the board, use the following procedure:

Move SL5 to Position A and SL7 to Position B.

Connect the two terminals of J5 labeled AGND and AVSS.
Connect 0 V (GND) to J5 at the terminal labeled AGND.
Connect 5V to J5 at the terminal labeled AVDD.

Connect 3.3 V to J5 at the terminal labeled IOVDD.
Connect the 7 V to 9 V input to either J3 or J4.

AN e

Set all other links and solder links to the default settings as
outlined in Table 1.

Split Supply (Regulated)
To set up the board, use the following procedure:

1. Remove SL12 to SL15. These links connect AVSS to AGND.

2. Connect a bench top power supply to J3 and set LK2 to
Position A. Make sure that AVSS = -2.5 V in this case.

3. Set LK1 to Position B. This sets the input to the power
monitor circuitry to work with the lower AVDDI supply
of 2.5V.

Set all other links and solder links to the default settings as
outlined in Table 1.

Split Supply (Unregulated)
To set up the board, use the following procedure:

Move SL5 to Position A and move SL7 to Position B.
Remove SL12 to SL15.

Connect 0 V (GND) to J5 at the terminal labeled AGND.
Connect 2.5 V to J5 at the terminal labeled AVDD.
Connect —2.5 V to J5 at the terminal labeled AVSS.
Connect 3.3 V to J5 at the terminal labeled IOVDD.
Connect 7 V to 9 V to either J3 or J4. Connect or disconnect
the AVSS terminal of J3 to the AVSS terminal of J5.

8.  Set LK1 to Position B. This sets the input to the power moni-
tor circuitry to work with the lower AVDD1 supply of 2.5 V.

NGO R e

Set all other links and solder links set to the default settings as
outlined in Table 1.

ANALOG INPUTS

The EVAL-AD7175-8SDZ primary analog inputs can be applied
in two separate ways:

e J10,J12, and J14 connectors on the left side of the board
e AQto A3 SMB/SMA footprints on the evaluation board

The analog inputs route directly to the associated analog input
pins on the AD7175-8, provided that the LK5 to LK20 links
(on-board noise test) are removed. The AD7175-8 evaluation
software is set up to analyze dc inputs to the ADC. The
AD7175-8 input buffers work for dc input signals.

REFERENCE OPTIONS

The EVAL-AD7175-8SDZ includes an external 5 V reference,
the ADR445. The AD7175-8 includes an internal 2.5 V reference.
The default operation is to use the external reference input,
which is set to accept the 5 V. ADR445 on the evaluation board.

Choose the reference in the SETUPCONX registers associated
with Setup 0 to Setup 7 to select the reference used for
conversions by the AD7175-8.

Change between the internal and external references by
accessing the AD7175-8 register map in the evaluation software.
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EVALUATION BOARD SOFTWARE
SOFTWARE INSTALLATION

The EVAL-AD7175-8SDZ evaluation kit includes software on
a CD. Double-click the setup.exe file from the CD to run the
installer. The default installation location for the software is
C:\Program Files\Analog Devices\ AD717x Eval+\.

Install the AD717x Eval+ software before connecting the
evaluation board and SDP-B board to the USB port of the PC to
ensure that the evaluation system is correctly recognized when
connected to the PC.

There are two parts to the installation.

1. AD717x Eval+ software installation.
2. AD717x Eval+ Dependencies

a. SDP-B board drivers

b.  Ssrc SVG plug-in installation

c.  Microsoft .Net Framework v3.5

Warning

To ensure the PC correctly recognizes the evaluation system, the
evaluation software drivers must be installed before connecting the
EVAL-AD7175-8SDZ evaluation board and SDP-B boards to the
USB port of the PC.

Installing the AD717x Eval+ Software
To install the AD717x Eval+ software take the following steps:

1.  With the SDP-B disconnected from the USB port of the
PC, insert the AD717x Eval+ software installation CD into
the CD-ROM drive. Double-click the setup.exe file to begin
the evaluation board software installation.

2. The default installation location for the software is
C:\Program Files\Analog Devices\AD717x Eval+\.

3. A dialog box appears asking for permission to allow the
program to make changes to the PC. Click Yes to proceed
(see Figure 3).

User Account Control

0

Send Feedback

Da you want to allow the following program from an
unknown publisher to make changes to this computer?

Program name:  setup.exe
Publisher: Unknown
File crigin: CO/DVD drive
(™) Show details Ves | [ blg

Help me decide Change when these notifications appear

Figure 3. User Account Control Permission Dialog Box

4.  Select alocation to install the software and click Next.
Figure 4 shows the default locations displayed when the
dialog box opens. To select another location click Browse.

13767-103

34 AD717x Eval+
e |
Destination Directory
Select the primeary installation directary

All software will be installed in the following locations. To install software into a different
location, click the Browse button and select another directary.

Directory for AD717x_Eval+
[CAPragram Files (@) Analog DevicesyAD71 75 Evalet

| [ Browse.

Directory for National Instruments products
CiProgram Files (36)\National Instruments\

| [(Browse.

[ ook [ Nea» || Cancel J

Figure 4. AD717x Eval+ Installation, Selecting the Location for Software
Installation

5. Alicense agreement appears. Read the agreement, select I
accept the License Agreement, and click Next.

4 AD71x Eval + = [@ [ =]
|
License Agreement
Vou must accept the licenses displayed belowo pracesd

EVALUATION SOFTWARE LICENSE AGREEMENT
20160622 -AD71E-CTELA

M

\Wnalog Devices, Inc. a Massachusetts corporation, with principal offices at One Technology Way,
Norwood, Massachusetts, USA 02062 and its licensors {together "Analog Devices") are willing to
license the software and related documentation made available for download for evaluation
purposes from the Analog Devices web site (the "Licensed Software") to you (personally or on
behalf of your employer, as applicable) {"Licensee") ONLY IF YOU ACCEPT THIS LICENSE
AGREEMENT ("License" or "Agreement”) SC AS TO BIND YOURSELF PERSONALLY OR YOUR
EMPLOYER TO ITS TERMS. Any use of the Licensed Software other than pursuant to the terms
of this License is unlicensed and a violation of applicable copyright and other intellectual property
lavs.

BEFORE YOU CHOOSE THE "I ACCEPT" BUTTON AT THE BOTTOM OF THIS WINDOWY, _

CADEEI IV DEAN THE TEDAS AKMD COMPDITIOMNS AF THIC | ICERNSE BV CHANSIRIE THE '

@)1 aeosptthe Licanse Agraement

1do not aceept the License Agreement

[ «Bock || new» J[ cancel |

Figure 5. AD717x Eval+ Installation, Accepting the License Agreement

6. A summary of the installation displays. Click Next to
continue.

24 AD717% Eval +

Start Installation
Raview the following summary before continuing

Adding or Changing
* AD717x_Eval+ Files

Click the: Next button to begin installation. Click the Back button to change the installation settings

[saverie. || <«Back | new» ] Cancel |

Figure 6. AD717x Eval+ Installation, Reviewing a Summary of the
Installation
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7. The message in Figure 7 appears when the installation is (5 Analog Devices Eval+ Dependencies Setup -
complete. Installation Complete =
Setup was completed successfully, ‘\ ¥ 7
S ADT1Ix Eval+ E'@

I —
Installation Complete

Completed
The installer has finished updating your system. Extract: SVGPlugin.exe.., 100% ~

Execute: C:\Users\CM\AppData'L ocal{TempAnalog Devices\install\SVGFlugin.exe /5 ...
Delete file: C:YUsers\CM\AppData\LocaliTempiAnalog Devices\install\SVGPlugin.exe
Extract: SDPDrivers.exe... 100%

Execute: C:\Users\CM\AppData'Local\Temp\Analog Devices\install\SDPDrivers.exe /5
Delete file: C:\Users\CM\AppData\Local{Templanalog Devices\install\SDPDrivers.exe
Extract: dotnetfx35.exe... 100%

Execute: C:\Users\CM\AppData'Local{TemplAnalog Devices\install\dotnetfx35.exe /S
Delete file: C:\Users\CM\AppData\LocaliTemplAnalog Devices\instal\dotnetfx35.exe
Completed

13767-109

<ok Foh
Figure 7. AD717x Eval+ Installation Complete 5.
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Figure 9. Eval+ Dependencies Setup, Completing the Driver Setup Wizard

Before using the evaluation board, the user must restart
Installing the Eval+ Dependencies the PC.

After installation of the evaluation software is complete, a ——
@ Yious must restart yOur computer o compiete this operation

welcome window displays to install the Eval+ Dependencies.

1. With the SDP-B board still disconnected from the USB
port of the PC, make sure all other applications are closed,

¥ you need 1o install hardwane now. shut down the computer. f you
choose o restar Inter. restart your computer befiore running any of this

then click Install. S, Com, [ Roman e é
(31 Analog Devices Eval+ Dependencies Setup — s Figure 10. Restarting the PC )
Welcome to Analog Devices Eval+ Installing the .Net Framework v3.5 on Windows 8 and
Dependencies Setup Windows 10
7his setup wil install the following components required by Windows 8 and Windows 10 have a built in installer for the .Net

the Eval+ software:

. Framework v3.5. In order to run this software the user will need an
- Microsoft .MET Framework 3.5

> Ssrc SVG Plugin internet connection and may need administrator privileges.
- SDP Drivers

Ohcknext to proceed with the installation, Complete the following steps to install the software. If unable to

install the .Net Framework contact your system administrator.

1. When the Eval+ Dependencies installer reaches the .Net
Framework, the window shown in Figure 11 will appear.

X

|50 Windows Features
Figure 8. Eval+ Dependencies Setup, Beginning the Drivers Installation NET Framework 3.5 (includes NET 2.0 and 3.0)

2. The Ssrc SVG plug-in will install first, then the SDP-B
drivers, and finally the .Net Framework.

An app on your PC needs the following Windows feature:

13767-108

. . . . G Download and install this feature
3. If using Windows 8 or Windows 10 see the InStalhng the Windows will get the files that it needs frem Windows Update and complete the installation.
.Net Framework v3.5 on Windows 8 and Windows 10
section. —> Skip this installation

Your apps might not work correctly without this feature.

4. To complete the drivers installation click Close. This closes
the installation setup wizard.

Tell me more about this feature

Cancel

13767-111

Figure 11. Restarting the PC

2. Follow the steps in the installation wizard to complete the
installation.
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3. If the window in Figure 11 does not appear; v3.5 may
already be installed. To check if the software is already
installed open Control Panel > Programs > Programs
and Features and select Turn Windows features on or off.
Check that the .Net Framework v3.5 is enabled.

SETTING UP THE SYSTEM FOR DATA CAPTURE

After completing the steps in the Software Installation section
and the Evaluation Board Hardware section, set up the system
for data capture using the following steps.

1.  Allow the Found New Hardware Wizard to run after the
SDP-B board is connected to the PC. (If using Windows
XP, search for the SDP-B drivers. Choose to automatically
search for the drivers if prompted by the operating system.)

2. Check that the board is connecting to the PC correctly
using the Device Manager.

3. Access the Device Manager by right clicking My
Computer, then Manage. A dialog box appears asking for
permission to allow the program to make changes to the
PC. Click Yes. The Computer Management box appears.
Click Device Manager from the list of System Tools (see
Figure 12).

4. The SDP-B board appears under ADI Development Tools.
This indicates that the driver software has installed and the
board is connected to the PC correctly.

,'ﬁ' Computer Management
File Action Miew Help

b ol 4 221 (5

& Computer Management (Local| 234
4 [f& System Tools
» (B Task Scheduler
3 @ Event Viewer m-1% Computer
- 2l Shared Folders e Disl
3 _k_' Local Users and Groups
» @ Reliability and Performz
e Device Manager
4 3 Storage
= Disk Management
T Services and Applications

g u¥ ADIDevelopment Tools
ﬂ‘ Analog Devices System Development Platform {(32MB)

e drives

E-gky DVD/CD-ROM drives

[ 5‘-';-3 Human Interface Devices

[y IDE ATA/ATAPI controllers
#-ZZ Keyboards

2] -jil‘ Mice and other pointing devices
[ l- Monitors

Figure 12. Device Manager, Checking the Board Connected to the PC
Correctly

LAUNCHING THE SOFTWARE

After completing the steps in the Setting up the System for Data
Capture section, launch the AD717x Eval+ software using the
following steps:

1. From the Start menu, click Programs > Analog Devices >
AD717x Eval+.

2. The dialog box in Figure 13 appears, select AD7175
Evaluation Board. The main window of the software box
displays as shown in Figure 16.

13767-112

[: Select Interface... @

Select Evaluation Hardware:

(2071756 Bvauatonboars Mgy

Figure 13. AD7175-8 Evaluation Board Selection

If the EVAL-AD7175-8SDZ evaluation system is not
connected to the USB port via the SDP-B, when the
software is launched the Select Interface dialog box appears
(see Figure 14). Connect the evaluation board to the USB
port of the PC, wait a few seconds, click Refresh and the
option shown in Figure 13 appears.

13767-113

rI: Select Interface... | 23 |

Select Evaluation Hardw are:

Identify

Salact

13767-114

Figure 14. Evaluation Board Selection, No Board Connected

The AD717x Eval+ software can also be used without
connecting hardware. Click the Simulation button and
the options shown in Figure 15 appear. This simulation
mode uses a model and allows the AD7172-2, AD7172-4,
AD7173-8, AD7175-2, AD7175-8, AD7176-2, or
AD7177-2 to be evaluated.

=

I: Select Interface...

Select Product to Simulate:

AD7175-2

AD7175-8

AD7176-2
ADT17T-2

Cancel

»

1 |1

13767-115

Figure 15. Evaluation Board Selection Simulation
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EVALUATION BOARD SOFTWARE OPERATION

3 2A0717x Eval

o] E ]

File Edit Helpm

AD7175-8 Eval+

ANALOG
DEVICES

Evaluation Mode
Hardware

Select Product...

Reset ADC

Sampling Mode Samples
| Configuration “Waveform | Histogram | Modelled Performance | Registers Single Capture x| 1000 [» sample
AVDDL(V) AVDD2(V) Ext. REF-(V) Ext. REF+(V)
n 5 5 0 5
AVDD1 AVDDZ REGCAPA REF- REF+ REFOUT 10VDD REGCAFD
ral
LDO
PRECISION
H\“\\E REFERENCE
AINOREF2- =
[ +]
I.lN‘"HEmI: SCLK
M oimat | N wiEREACE o
: _FILTER AND CONTROL DOUTIRDY
SYNC
AIN{S H RAIL TO RAIL .
8-15 AVSS BUFFEI'H'EUT [*] ERROR
mms:[:: o
/ 1O AND EXTERNAL XTAL AND INTERNAL
TEMPERATURE
Lm [3 MUXCONTROL SHock asaLLrTOR ADT7175-8
é o
AVSS PDSW GPIO0 GPIOY_GPOZ_GPO3 _ XTAL1 XTALIICLKIO _ DGND
AVSS(V) 0
13
m

@ Busy

Figure 16. Configuration Tab of the AD7175-8 Eval+ Software in Hardware Mode
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3 Ap717x Eval =

o] )

File Edit Help

AD7175-8 Eval+

ANALOG
DEVICES

Sampling Mode Samples

Configuration | Waveform | Histagram | Modelled Perfarmance

Registers

x| 1000

Single Capture

Evaluation Mode
Simulation
Select Product...
AVDD1(Y)
5

AVDD2(V)
5

AVDDM AVDD2 REGCAPA
O O

Simulated Input
Input vV
2.5

AINO
AIN1
AIN2

AINOREF2-

T
b
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/ TEMPERATURE
SENSOR

AIN1REF2+
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AINTS CH

8-15 AVSS
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BUFFERS

2

IOVDDV)
5
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IOVDD REGCAPD

1
LDO
BUFFERED
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20M

SERIAL
INTERFACE
AND CONTROL

DIGITAL
FILTER
=]

XTAL AND INTERNAL
CLOCK OSCILLATOR
i CIRCUITRY

AD7175-8

VO AND EXTERNAL
[+] MUX CONTROL

AVSS PDSW
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Reset ADC
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!
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O
DGND

GPIO0 GPIO1 GPOZ GPO3

m Ext. MCLK(Hz)|  16M

Device Error ll

@ busy
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Figure 17. Configuration Tab of the

OVERVIEW OF THE MAIN WINDOW

The main window of the AD717x Eval+ software displays the
significant control buttons and analysis indicators of the AD717x
Eval+ software. The main window is divided into five tabs.

e  Configuration

e  Waveform
e  Histogram
e  Modelled Performance

Registers
CONFIGURATION TAB (1)

Figure 16 shows the Configuration tab when Hardware Mode
is selected and Figure 17 shows the Configuration tab when
Simulation mode is selected. The controls highlighted in
Figure 17 are only available in Simulation mode.

Evaluation Mode (2)

The Evaluation Mode indicator displays the current evaluation
mode. To switch between modes, click the Select Product
button and the dialog box shown in Figure 13 appears.

Tutorial Button (3)

Click the tutorial button to open a tutorial and access additional
information on using the AD717x Eval+ software.

AD7175-8 Eval+ Software in Simulation Mode

Functional Block Diagram (4)

The functional block diagram of the ADC shows each of the
separate functional blocks within the ADC. Clicking a
configuration pop-up button on any of the functional blocks
opens the configuration pop-up window for the block selected.
Not all blocks have a configuration button.

Configuration Pop-up Button (5)

Each configuration pop-up button opens a different window
that allows the configuration of the relevant functional block.

Analog and Digital Supply Voltage (6, 7, and 14)

These input fields are used to take the supply voltage levels
selected for the AD7175-8. Checks are performed to ensure the
power supply voltage levels entered are within the specified
limits. These power supply voltage levels are also used for the
modelled performance to calculate the power dissipation.

External Reference (Ext. REF) (8)

The Ext. REF input fields set the positive and negative external
reference voltage values. The difference is used for calculating
the results for both the Waveform and Histogram tabs. The
evaluation board has an external 5 V ADR445 reference, which
can be bypassed by removing R32. Change the external
reference values in Ext. REF to ensure correct calculation of
results in the Waveform and Histogram tabs.
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Register Configuration Summary(9)

Click the Summary button to display the selected configuration
of the AD7175-8 this includes the channel configuration,
information on each of the individual steps, and information on
any error present.

Reset ADC (10)

Click the Reset ADC button to perform a software reset of the
AD7175-8 . The AD7175-8 does not have a hardware reset pin,
to perform a hard reset the power must be removed from the
board. The software reset has the same effect as a hard reset.

Menu Bar (11)
The menu bar has three section: File, Edit, and Help.
File

There are three options available in the File drop-down menu:
Save, Load, and Generate.

SAVE

Save allows the user to save register configurations or waveform
data. Register configurations can be saved as a JSON file or a
header file. If the configuration is only used in the AD717x
Eval+ software environment then it is recommended to use the
JSON setting. Waveforms are saved as .csv files and the user is
prompted to save the register configuration as well.

LOAD

Load allows the user to load saved register configurations or
waveform data. In order to load a header into AD717x Eval+ it
must be in the same format as one that is saved from AD717x
Eval+. The header file can be used when developing firmware.
When loading the waveform data the user is prompted to load
the register configuration. This allows the software to correctly
analyze the data.

Edit

There are two options in the Edit drop-down menu; Change
Product Selection and Reset ADC. Change Product Selection

performs the same action as the Select Product button and
Reset ADC performs the same action as the Reset ADC button.

Help

The Help drop-down menu provides links to extra information
about the AD7175-8 , which includes links to the AD7175-8
product page, EVAL-AD7175-8SDZ evaluation board user
guide, AD7175-8 datasheet, and No-OS Drivers. Selecting the
AD717x Eval+ Tutorial opens the tutorial outlined in the
Tutorial Button (3) section. For details on the current version of
the software the About option opens a dialog box displaying the
current version of the software and relevant licenses.

Status Bar (12)

The status bar displays the busy indicator and status updates,
such as Analysis Completed and Reset Completed during
software use.

Device Error (13)

The Device Error LED icon illuminates when an ADC error is
detected or when a cyclic redundancy check (CRC) error occurs.
The CRC functionality on the AD7175-8 is disabled by default
and must be enabled for the Device Error indicator to work.
Specific information on the error can be found in the Register
Configuration Summary(9) section.

External MCLK Frequency (15)

This field sets the external MCLK frequency. External MCLK
Frequency (15)] is only visible on the front panel when an
external clock source is selected by the ADC. It is used by the
functional model for modelled performance.

Analog Input Voltage (16)

These fields are only available when simulation mode is
selected.These inputs allow the analog input voltages to be set
and can be changed at any time while in simulation mode.

External SCLK Frequency (17)

This input field sets the external SCLK frequency for the SPI
interface. This field is only available in simulation mode to
determine if the SCLK frequency is within the permitted range.
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WAVEFORM TAB (18)

Figure 18 shows the Waveform tab of the AD717x
Eval+Software.

Sampling Mode (19)

This control is unrelated to ADC mode. The user can capture a
defined sample set, single capture; or continuously gather
batches of samples, repeated capture. The user can also select
data logging that runs similar to repeated capture, but posts the
results to a .csv file. When saving, the .csv file prompts the user
to save the register configuration. This is necessary to load the
data back into the software for analysis.

Samples (20)

The Samples field control sets the number of samples gathered
per batch. Single capture returns the number enters into the
Samples control. Repeated capture keeps returning batches of
the number entered into the Samples control until stopped by
the user.

Sample (21)

Click the Sample button to start gathering ADC results. Results
appear in the waveform graph (22). See Figure 18.

Waveform Graph and Controls (22 and 23)

The data waveform graph shows each successive sample of the
ADC output. Zoom in on the data using the control toolbar
(labeled 23 in Figure 18). Click the x-axis and y-axis to change
the scales on the graph.

Channel Selection (24)

The channel selection control allows the user to choose which
channels display on the data waveform graph (23). These controls
only affect the display of the channels and have no effect on the
channel settings in the ADC register map.

Noise Analysis (25)

The Noise Analysis section displays the results of the noise
analysis for the selected analysis channel, which includes both
noise and resolution measurements.

Analysis Channel (26)

The Noise Analysis section and histogram graph show the
analysis of the channel selected via the Analysis Control drop-
down menu.

Display Units and Axis Controls (27)

Click the Display Units drop-down menu to select the unit
displayed in the graph. This control affects both the waveform
graph and the histogram graph. The axis controls can be
switched between dynamic and fixed. When dynamic is
selected, the axis automatically adjusts to show the entire range
of the ADC results after each batch of samples. When fixed is
selected, the user can program the axis ranges; the axis ranges
do not automatically adjust after each batch of samples.
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Figure 18. Waveform Tab of the AD7175-8 Evaluation Software
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HISTOGRAM TAB (28)
Figure 19 shows the Histogram tab of the AD717x Eval+

Software.

Histogram Graph and Controls (29 and 30)

The data histogram graph (29) shows the number of times each
sample of the ADC output occurs. The control toolbar (30) in
the histogram graph allows the user to zoom in on the data (see
Figure 19). Click the x-axis and y-axis to change the scales on
the graph (see Figure 19).

3 AD717x Eval+

[F=NSch X"

File Edit

Help

AD7175-8 Eval+

ANALOG
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Sampling Mode Samples

| Configuration | Waveforrnl Histogram IMcdeHed Performance | Registers Single Capture ﬂ 1000 D Sample

m75

70
65
&0
55
50
45
40
35
30
25
20
15
10

5

0

Occurance

o FTTI8

-30u -25u -20u

-15u -10u -5u

Volts

Noise Analysis  Channel 0 Z|

Number Samples
Mean (Average)

Maximum Value

Minimum Value

1] P - P MNoise
RMS Noise
P - P Resolution

RMS Resolution

Graph Configuration

Units: v/mv/uv/nv Z|

4
Y-scale: Autoscale |

0.0 |Bit
X-scale: Autoscale ¥ |

0.0 |Bit

Device Error ll

@ susy

13767-119

Figure 19. Histogram Tab of the AD7175-8 Eval+ Software
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[ 20717x Eval +
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Figure 20. Filter Profiles of the AD7175-8 Evaluation Software

MODELLED PERFORMANCE TAB (31)

The Modelled Performance tab shows a number of ADC
performance parameters, which are calculated using the ADC
functional model. There are three main sections to the
Modelled Performance tab; Filter Profile, Filter Step Response,
and Timing Diagram/Power. These can be selected using the
drop-down menu (33).

Analysis Channel (32)

The Analysis Channel drop-down menu selects the channel to
be evaluated by the functional model.

Filter Profile (33)

The Filter Profile drop-down menu allows the user to switch
between the three sections of the Modelled Performance tab.
Figure 20 shows the Modelled Performance tab when filter
profile is selected.

Filter Profile Graph (34)

This graph shows the frequency response for the selected digital
filter. The graph controls allows the user to zoom in on the data.
Click the x-axis and y-axis to change the scales on the graph.

Filter Rejection (35)

This section shows the rejection/attenuation of the digital filter
over the rejection bandwidth (Rej.BW) for f1 and 2 in decibels;
f1, 2, and Bandwidth can be changed.

Filter Performance (36)

This section shows the timing information about the data rate
of the selected output. It shows the ADC initial settling time
(Tsettle), the first frequency notch (Fnotch), and the actual
sampling frequency (fADC).

Rev.A | Page 16 of 33



http://www.analog.com/AD7175-8?doc=EVAL-AD7175-8SDZ_UG-901.pdf
http://www.analog.com/AD7175-8?doc=EVAL-AD7175-8SDZ_UG-901.pdf

UG-901

& Ap717x Eval+

o) & )

File Edit Help

AD7175-8 Eval+

| Configuration | Waveform | Histogram | Modelled Performance ‘ Registers |

ANALOG
DEVICES
Sampling Mode Samples
Single Capture zl 1000

m Filter Step Response v | | Channel 0 ¥ step response assumes the ADC is continuously converting on the selected channel only (i.e. only
one channel is enabled)

A A A A A A A ‘&
J ¢ W J ¢ W ¢ W ¢
100.0 100.0 100.0 100.0 100.0 100.0 100.0 100.0
Vaoltage
0.0‘3% 0.00%

1 ! L L L L L

1 o o o o o 1 o o
0 “oe “moc ‘e “anc “moc s “impe “pc ‘e

Step Configuration
Step Position 0 %
Voltage before Step 1 v
Voltage after Step 2 v

Step Response
fapc | 49.6894k | Hz

1/faDC 20.125u 5 Civolts

tSette 24.25u 5

Graph Units

@ Percentage

") Codes

@ Busy

13767-121

Figure 21. Filter Step Response of the AD7175-8 Evaluation Software

Filter Step Response (37)

This drop down menu allows the user to switch between the
three sections of the Modelled Performance tab. Figure 21 shows
the tab when Filter Step Response is selected.

Step Response Graph (38)

This graph shows how long the filter takes to settle when the
voltage is stepped from one voltage to the next. For this analysis,
it is assumed the ADC is continuously converting on only one
channel.

Step Configuration (39)

Step Configuration allows the user to set the voltage before and
after the step and the step position. Step position is set as a
percentage where 0% is 1/fADC and 100% is 2/fADC.

Step Response (40)

This section shows timing information about the data rate of
the selected output. It shows fADC, Tsettle, and the settling time
between conversions, 1/fADC.

Graph Units (41)

Use this control to switch the step response between percentages,
volts, and codes.
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Figure 22. Timing Diagram/Power of the AD7175-8 Evaluation Software

Timing Diagram/ Power (42) Timing Diagram (44)

This graph shows the digital interface timing diagram for the
current configuration. The graph shows the timing for both the
configuration of the ADC, and the subsequent data reads from

the ADC.

This drop down menu allows the user to switch between the
three sections of the Modelled Performance tab. Figure 22
shows the Modelled Performance tab when Filter Step
Response is selected.

Estimated Power Consumption (43)

This section shows the total power consumption of the device
in the current configuration, as well as, the current consumption
on each of the power supply rails. Note that the estimated
power consumption is for the continuous conversion mode only
and no other mode of operation is supported.
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Figure 23. Registers Tab of the AD7175-8 Evaluation Software

REGISTERS TAB (45)
Figure 23 shows the Registers tab.
Register Tree (46)

This control shows the full register map in a tree control. Each
register is shown; click the expand button next to each register
to show all the bit fields contained within that register.

Register (47)

The Register control allows the user to change the individual
bit of the register selected in the register tree (46) by clicking the
bits or by programming the register value directly into the number
control field on the right.

Bitfields (48)
This list shows all the bit fields of the register selected in the
register tree (46). Change the values by using the drop-down

box or by directly entering a value into the number control field
on the right.

Documentation (49)

The Documentation field contains the documentation for the
register or bitfield selected in the register tree (46).

Save(50) and Load (51)

The Save (50) and Load (51) buttons allow the user to save the
current configuration of the AD7175-2 by saving off of the
register map setting to a file and load the setting from that same
file. When using these buttons the register configurations are
saved and loaded as JSON files.

EXITING THE SOFTWARE

To exit the software, click the close button at the top right corner
of the main window (see Figure 16).
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Figure 24. AD7175-8 Schematic
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Figure 25. Amplifier Schematic
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Figure 27. Regulator Schematic
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Figure 28. SDP-B Connector Schematic
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Figure 29. Analog Inputs Schematic
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Gy
anil uMaA—ZEVADMJZ Heeo
-]
A fg

Ani)_OMBA-22VA

BEIAN ez
u [w
" L)

u

T u

Ll ﬁLaa
osm

(=]
eo00
0000 ¢

i1 aror-z2va

[

om,
° Jdnid GHIA-22VA

iy
ix
ix
iy

ewblorisanld_80St

Figure 30. Bottom PCB Silkscreen
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Figure 32. Layer 2 Ground Plane
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Figure 34. Layer 4 Solder Side
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ORDERING INFORMATION

BILL OF MATERIALS

Name

Part Description

Manufacturer

Part Number

Stock Code

A0 through A3, EXTREF+,
EXTREF-, MCLK

C1,C17, C43, C47,C83 through
c84

C2, C12 through C14,C18, C20
through C21, C34, C38, C44, C50
through C55, C58, C60, C71, C73,
C78 through C79, C81, C85, C87,
€89, C91, C101 through C102

C15, C45 through C46

(3, C5, C7 through €9, C19, C22
through C24, C26 through C33, C35
through C37, C40 through C42,
C59, C61 through C67

C69 through C70, C75 through
C76, C93 through C100

C10 through C11
C4,C6

C56 through C57, C77
(@]9

C25,C72,C86,(C88

(39, C48 through C49, C80, C82
68, C74, C90, €92

D1 through D2, D6

D4
D5

AVSS, GND1 through GND6, REF+,
REF—, REFOUT, S1 through S8, S1’
through S8, TDIN, TDIN1, TDOUT,
TDOUT1, TERROR, TERRORT1, TR,
TSCLK, TSCLK1, TSYNGC, TSYNC1,
TS, MCS1

J
J2

3
J4
J5
16
7

J8

Straight PCB mount SMB jack, keep
hole clear of solder. Do not insert.

Ceramic capacitor, 6.3V, X5R, 0603,
4.7 uF
Capacitor, 0603, 0.1 uF, 16 V

Ceramic capacitor, 10V, X5R, 0603,
4.7 pF

Ceramic capacitor, not inserted,
0402

Ceramic capacitor, not inserted,
0603

Capacitor, 0603, 1 pF, 6.3V
Capacitor, 0805, 50V, X7R, 1 uF
Capacitor, 0603, 1 yF, 6.3V

Ceramic capacitor, not inserted,
0402

Ceramic capacitor, 10 yF, 16V, X5R,
0805

Ceramic capacitor, 50V, X5R, 1210

Multilayer ceramic capacitor, 50V,
X7R

Red LED, high intensity (>90 mCd),
0603

LED, SMD green
Zener Diode, 0.5W, 5.1V

Test point, not inserted, keep hole
clear of solder

120-way connector, 0.6 mm pitch
PC-SCREWTERM-3WAY

Socket terminal block, 3.81 mm
pitch

CON\BARREL_SMD_2MM_KLDX-
SMT2-0202-A

SCREWTERM-4
POWER_SKT_3.81TMM_4WAY, keep
clear of solder

SCREWTERM-4, keep clear of solder

POWER_SKT_3.81MM_4WAY

TE Connectivity

Murata

Multicomp

KEMET
Electronics
Corp.

Not applicable

Not applicable

Not applicable
Murata
Murata
Not applicable

Murata

Murata
Yageo

Broadcom Ltd.

Osram
Vishay
Not applicable

HIROSE

Phoenix
Contact

Phoenix
Contact

Mouser

Phoenix
Contact
Phoenix
Contact
Phoenix
Contact
Phoenix
Contact

1-1337482-0
GRM188R60J475K

BO603R104KCT

C0603C475K8PACTU

Not applicable

Not applicable

Not applicable
GRM21BR7TH105KA12L
GRM188R70J105KA01D
Not applicable

GRM21BR61C106KE15L

GRM32ER61H106K
2238 586 15623

HSMC-C191

LGQ971
BZT52B5V1-V-GS08
Not applicable

FX8-120S-SV(21)
1727023

MC 1.5/3-G-3.81
KLDX-SMT2-0202-A
MKDS1/4-3.81
MC1.5/4-G-3.81
MKDS1/4-3.81

MC1.5/4-G-3.81

Do notinsert

FEC 173-5527

FEC 940-6140

FEC 157-2625

Do notinsert

Do notinsert

Do not insert
FEC 1735541

FEC 184-5765
Do not insert

490-3886-1-ND

FEC 184-5764
FEC 722170

FEC 855-4528

FEC 1226372
FEC 1617767
Do notinsert

FEC 1324660
Do notinsert

FEC 370-4737
806-KLDX-
SMT20202A
FEC 370-4592
Do notinsert

Do notinsert

FEC 370-4749
and
FEC 370-4920
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Name Part Description Manufacturer Part Number Stock Code
Jo SCREWTERM-8_RA, keep clear of Phoenix 1727078 Do not insert
solder Contact
J10 POWER_SKT_3.81MM_8WAY Phoenix MC 1,5/ 8-G-3,81 FEC 370-4774
Contact and
FEC 370-4956
J1 SCREWTERM-8_RA, keep clear of Phoenix 1727078 Do not insert
solder Contact
J12 POWER_SKT_3.81TMM_8WAY Phoenix MC 1,5/ 8-G-3,81 FEC 370-4774
Contact and
FEC 370-4956
J13 SCREWTERM-6-RA, keep clear of Phoenix MKDS1/6-3.81 Do notinsert
solder Contact
J14 POWER-SKT-3.81MM_6WAY Phoenix MC 1,5/ 6-G-3,81 FEC 370-4762
Contact and FEC 370-
4944
J15 CON\7HEADER Samtec SSW-107-01-T-S FEC 1803478
J16 CON\7HEADER Samtec TLW-107-05-G-S FEC 1668499
L1 through L4 Ferrite bead, 0.3 Q at dc, 1000 Q) at TE Connectivity | BMB2A1000LN2 FEC 119-3421
100 MHz, 350 mA, 0805
LK1 through LK2 3-pin (3 x 1) 0.1" header and Harwin M20-9990346 and FEC 1022249 and
shorting blockin A M7566-05 FEC 150-411
LK5 through LK21 2-pin (2 mm Pitch) header and Harwin M22-2010205 and FEC 671915 and
shorting shunt M22-1920005 FEC 510944
Q1 S12304DDS-T1-GE3 Fairchild 2N7002 FEC 1853257
Semiconductor
Q2 NPN-BCX19, SOT23 ON MMBT3904LT1G FEC 1459100
Semiconductor
R1 Resistor, not inserted, 0603 Multicomp MC 0.063W 0603 OR Do not insert
R28, R29, R50, R52 Resistor, not inserted, 0402 N/A N/A Do notinsert
R2 through R4, R7, R48 Resistor, 100 K, 0.063 W, 1%, 0603 Multicomp MC 0.063W 0603 1% FEC 9330402
100K
R5, R6, R8, R42 through R44, R71, Resistor, 1 %, 0603 Multicomp MC 0.063W 0603 1% 10 FEC 933-0399
R125 K
R45 Resistor, thick film, 10 kQ, Yageo RC0402JR-1310KL FEC 179-9316
62.5mW, 5%
R9 through R13, R19 through R22, | Resistor, 0603, 1 %, OR Vishay CRCW06030000Z0EA FEC 146-9739
R26 through R27, R30, R32, R34
through R41, R46 through R49,
R51, R53, R56 through R59, R62
through R70, R72, R73, R79, R85
through R85, R89, R93, R94, R98
through R101, R104, R108,R111,
R113,R119 through R122, R132,
R136, R142, R146, R153 through
R156
R33,R90,R112,R114 Resistor, 0402 Vishay Do not insert
R61, R81 through R83, R87, R91 Resistor, 0603, 1 %, OR Vishay CRCW06030000Z0EA Do not insert
through R92, R95 through R97,
R105, R126, R127 through R128,
R133, R137 through R139, R143,
R147 through R149, R152, R157,
R158
R14 Resistor, 0402, 1 %, 39K Multicomp MC0.063W 0603 1% 39K | FEC 9331158
R15,R17,R18, R24 Resistor, 0603 10 k2 1 % Vishay CRCWO060310K2FKEA FEC 1652829
R25,R123 Resistor, 0603, 1 %, 30 k1 Vishay CRCWO060330K1FKEA FEC 1469798
R80 Resistor, 0603, thick film, 1 % Vishay CRCW06031KO00FKEA Do not insert.
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Name

Part Description

Manufacturer

Part Number

Stock Code

R31,R78,R88, R107, R135, R145
R54

R55
R60

R66, R75 through R77
R74,R103, R106, R131, R134,
R141,R144,R151

R86

R102, R129, R140, R150
SLO, SL1

SL2,SL3
SL4

SL5

SL6

SL7
SL8
SL9, SL10

SL11A
SL11B,S11C

SL12 through SL15
STAR3

U1

u2
u3
U4
VE)
ué
u7
us
U9
u1o

utl

SMD Resistor, 0603

Resistor, thick film, 4.53 kQ,
63 mW, 1%
Resistor, 0603, 1 %, 61R9

Resistor, thick film, 2.4 kQ, 0603, 100

mW, 1%
Resistor, 0603, thick film, 1 %
Resistor, 0603, 1 K

Resistor, 0402, 60 K4

Resistor, 0603, 10R

4-way Solder Link (Use Or 0603
Resistor)

2-way Solder Link (Use Or 0603
Resistor)

2-way Solder Link (Use Or 0603
Resistor)

2-way Solder Link (Use Or 0603
Resistor)

2-way Solder Link (Use Or 0603
Resistor)

2-way Solder Link (Use Or 0603
Resistor)

2-way Solder Link (Use Or 0603
Resistor)

2-way Solder Link (Use Or 0603
Resistor)

R0603, Or

R0603, DNI

Resistor, 1206, OR

Ground link (copper short)
32 KI2C Serial EEPROM

Linear Regulator 5V, 20V,
500 mA, Ultralow Noise, CMOS

Quad Voltage Monitor and
Sequencer

5V XFET Reference

ADC

Dual Op-Amp

Ultra Low Power, Low Distortion ADC

Driver, 4nV/rtHz

50 mA, High Voltage, Micropower

Linear Regulator -5V

Fully Differential Funnel Amplifier

Dual Op-Amp

Linear Regulator, 50 mA, 3.3V,
MSOP-8

Not applicable
Vishay

Vishay
Yageo

Vishay
Panasonic

Multicomp

Bourns Inc.
Not applicable

Not applicable
Not applicable

Not applicable

Not applicable

Not applicable
Not applicable
Not applicable

Vishay

Vishay
Multicomp

Not applicable
Microchip
Technology Inc.
Analog Devices,
Inc.

Analog Devices,
Inc.

Analog Devices,
Inc.

Analog Devices,
Inc.

Analog Devices,
Inc.

Analog Devices,
Inc.

Analog Devices,
Inc.

Analog Devices,
Inc.

Analog Devices,
Inc.

Analog Devices,
Inc.

Not applicable
CRCWO06034K53FKEA

CRCW060361R9FKEA
RCO603FR-072K4L

CRCW06031KOOFKEA
ERA3AEB102V

MC 0.0625W 0402 1 %
60K4

CR0603-FX-10ROGLF
Insert in Link Position
A

Insert in Link Position
A

Insert in Link Position
A

Insert in Link Position
nge

Not applicable

Insert in Link Position
A

Insert in Link Position
A

Insert in Link Position
A
CRCWO06030000Z0EA
CRCWO06030000Z0EA
MC 0.125W 1206 OR

Not applicable
24LC32A-I/MS

ADP7104ARDZ-5.0
ADM1185ARMZ-1
ADR445BRZ
AD7175-8BCPZ
AD8656ARZ
ADA4940-1ACPZ
ADP1720ARMZ-5-R7
AD8475ARMZ
AD8656ARZ

ADP1720ARMZ-3.3-R7

Do notinsert
FEC 2138399

FEC 2141253
FEC 1799329

FEC 1469740
FEC 1577605

FEC 1803729

FEC 2008331
FEC 933-1662

FEC 933-1662
FEC 933-1662

FEC 933-1662

Do notinsert

FEC 933-1662
FEC 933-1662
FEC 933-1662

FEC 146-9739
Do notinsert
FEC 9336974
Not applicable
FEC1331330

ADP7104ARDZ-5.0
ADM1185ARMZ-1
ADR445BRZ
AD7175-8BCPZ
AD8656ARZ
ADA4940-1ACPZ
ADP1720ARMZ-
5-R7
AD8475ARMZ

AD8656ARZ

ADP1720ARMZ-
3.3-R7
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Name

Part Description

Manufacturer

Part Number

Stock Code

ui12
V1 through V4, X1 through X2
Y1

Y2

50 mA, High Voltage, Micropower
Adjustable Linear Regulator

Linear Regulator, 50 mA, 3.3V,
MSOP-8

Miniature Crystal SMD

Ceralock Ceramic Resonator

Analog Devices,
Inc.

Analog Devices,
Inc.

Epson

Murata

ADP1720ARMZ-R7
Not applicable
FA-20H, 16 MHz, 10

PPM, 9 PF
CSTCE16MOV53-R0

ADP1720ARMZ-R7

Do not insert

FEC171-2814

490-1198-1-ND
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NOTES

I?C refers to a communications protocol originally developed by Philips Semiconductors (now NXP Semiconductors).

ESD Caution
A ESD (electrostatic discharge) sensitive device. Charged devices and circuit boards can discharge without detection. Although this product features patented or proprietary protection
M circuitry, damage may occur on devices subjected to high energy ESD. Therefore, proper ESD precautions should be taken to avoid performance degradation or loss of functionality.

Legal Terms and Conditions

By using the evaluation board discussed herein (together with any tools, components documentation or support materials, the “Evaluation Board"), you are agreeing to be bound by the terms and conditions
set forth below ("Agreement”) unless you have purchased the Evaluation Board, in which case the Analog Devices Standard Terms and Conditions of Sale shall govern. Do not use the Evaluation Board until you
have read and agreed to the Agreement. Your use of the Evaluation Board shall signify your acceptance of the Agreement. This Agreement is made by and between you (“Customer”) and Analog Devices, Inc.
("ADI"), with its principal place of business at One Technology Way, Norwood, MA 02062, USA. Subject to the terms and conditions of the Agreement, ADI hereby grants to Customer a free, limited, personal,
temporary, non-exclusive, non-sublicensable, non-transferable license to use the Evaluation Board FOR EVALUATION PURPOSES ONLY. Customer understands and agrees that the Evaluation Board is provided
for the sole and exclusive purpose referenced above, and agrees not to use the Evaluation Board for any other purpose. Furthermore, the license granted is expressly made subject to the following additional
limitations: Customer shall not (i) rent, lease, display, sell, transfer, assign, sublicense, or distribute the Evaluation Board; and (i) permit any Third Party to access the Evaluation Board. As used herein, the term
“Third Party” includes any entity other than ADI, Customer, their employees, affiliates and in-house consultants. The Evaluation Board is NOT sold to Customer; all rights not expressly granted herein, including
ownership of the Evaluation Board, are reserved by ADI. CONFIDENTIALITY. This Agreement and the Evaluation Board shall all be considered the confidential and proprietary information of ADI. Customer may
not disclose or transfer any portion of the Evaluation Board to any other party for any reason. Upon discontinuation of use of the Evaluation Board or termination of this Agreement, Customer agrees to
promptly return the Evaluation Board to ADI. ADDITIONAL RESTRICTIONS. Customer may not disassemble, decompile or reverse engineer chips on the Evaluation Board. Customer shall inform ADI of any
occurred damages or any modifications or alterations it makes to the Evaluation Board, including but not limited to soldering or any other activity that affects the material content of the Evaluation Board.
Modifications to the Evaluation Board must comply with applicable law, including but not limited to the RoHS Directive. TERMINATION. ADI may terminate this Agreement at any time upon giving written notice
to Customer. Customer agrees to return to ADI the Evaluation Board at that time. LIMITATION OF LIABILITY. THE EVALUATION BOARD PROVIDED HEREUNDER IS PROVIDED “AS IS” AND ADI MAKES NO
WARRANTIES OR REPRESENTATIONS OF ANY KIND WITH RESPECT TO IT. ADI SPECIFICALLY DISCLAIMS ANY REPRESENTATIONS, ENDORSEMENTS, GUARANTEES, OR WARRANTIES, EXPRESS OR IMPLIED, RELATED
TO THE EVALUATION BOARD INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTY OF MERCHANTABILITY, TITLE, FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT OF INTELLECTUAL
PROPERTY RIGHTS. IN NO EVENT WILL ADI AND ITS LICENSORS BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES RESULTING FROM CUSTOMER'S POSSESSION OR USE OF
THE EVALUATION BOARD, INCLUDING BUT NOT LIMITED TO LOST PROFITS, DELAY COSTS, LABOR COSTS OR LOSS OF GOODWILL. ADI'STOTAL LIABILITY FROM ANY AND ALL CAUSES SHALL BE LIMITED TO THE
AMOUNT OF ONE HUNDRED US DOLLARS ($100.00). EXPORT. Customer agrees that it will not directly or indirectly export the Evaluation Board to another country, and that it will comply with all applicable
United States federal laws and regulations relating to exports. GOVERNING LAW. This Agreement shall be governed by and construed in accordance with the substantive laws of the Commonwealth of
Massachusetts (excluding conflict of law rules). Any legal action regarding this Agreement will be heard in the state or federal courts having jurisdiction in Suffolk County, Massachusetts, and Customer hereby
submits to the personal jurisdiction and venue of such courts. The United Nations Convention on Contracts for the International Sale of Goods shall not apply to this Agreement and is expressly disclaimed.

©2015-2018 Analog Devices, Inc. All rights reserved. Trademarks ANALOG
and registered trademarks are the property of their respective

owners. UG13767-0-1/18(A) DEVICES
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